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Welcome to Teachucomp, Inc.’s Introductory Project
course. This class introduces the student to Microsoft
Project, one of the most popular project management
programs available today. This class is designed to give
the student with little or no knowledge of this program a
firm skills base in Microsoft Project.

Microsoft Project is a software application that you can
use to manage projects in your organization. It provides an
easy way to enter and track the various project-related
tasks, budget constraints, and the overall project timeline.
You can also produce reports that allow you to track and
manage the project as it is occurring.

This class will focus giving you, the student, the basic
working foundation of the Project program.

Introduction and Overview
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Getting Acquainted with Project

1.1- About Project:

Microsoft Project is a software program that lets you easily manage and coordinate the resources
needed to finish a project. A “project” is any endeavor to create a product or accomplish a goal within a
framework set by the related resource, time, and budget constraints.

Microsoft Project helps manage project-related resource, time, and budget data. It also lets you
create and share reports about project information with others who need it. You can also easily adjust
project schedules to accommodate the inevitable changes to the project schedule that occur. This helps you
to complete a project that also fulfills the project’s desired goals on time and within budget.

1.2- Starting Project:

You may start Microsoft Project in different ways. If you have a desktop icon for Microsoft Project,
you can double-click the Microsoft Project icon to start the program. Alternatively, you can click the entry for
“Microsoft Office Project” within the Windows Start Menu or Start Screen. After it is started, take a moment
to first learn some of the basic terms and concepts involved in project management.

1.3- Project Management Terms and Concepts:

As mentioned earlier, a project is any endeavor to create a product or accomplish a goal within a
framework set by the related resource, time, and budget constraints. The first part of this definition states
that each project has a “goal” to accomplish. This goal could be a new physical product or a more intangible
product, like a quantifiable amount of research performed. Each project must meet its goal to be successful.

To accomplish any project’s goal involves work. In Microsoft Project, work is noted by tasks. To
complete tasks requires resources. Resources most often required are: work resources, which include
employees and other labor; material resources, which include materials needed to complete the task; and
cost resources, which include any other costs incurred to complete the task. In Microsoft Project, you
create the lists of resources needed to complete all the tasks in a project file.

To see when the project will end, the tasks required to finish the project’s goal must be
chronologically arranged. When creating tasks in Microsoft Project, you assign available resources to
complete the tasks. After entering all the tasks needed to complete the project’s goal, you can then see the
“end date” of the project. This basic project plan is then saved as the baseline for the project. A baseline is
the initial project plan.

Another helpful feature when using Microsoft Project is the effort-driven scheduling it uses to
assign resources to tasks. For example, if a task takes 16 work hours to finish and you assign one work
resource (employee) to the task at a given maximum of 8 hours per day, Microsoft Project estimates the
task’s duration to be 2 days. However, if you then assign an additional work resource (second employee) to
the same task at a given maximum of 8 hours per day, Microsoft Project recalculates the task duration to 1
day. This lets you easily change task resource assignments to see the changes the additional assignments
have on the project’s duration and cost.

Project helps you schedule the tasks required to meet the project’s goal while balancing the time
constraints and cost constraints of the project. The constraints of a project are the limitations placed on
the project. Time constrains and cost constraints are often the most pressing constraints placed on a
project. Most projects need to be finished within a certain period of time and also within a specified budget.
The scheduling engine of Microsoft Project lets you manage these constraints by using resource
assignments to change the duration and costs of the project’s required tasks and meet the project’s goal.
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Getting Acquainted with Project

1.3- Project Management Terms and Concepts- (cont'd.):

In addition to creating and managing your project file, Microsoft Project also lets you print and view
project information and project reports for the project’s stakeholders. A stakeholder is a party that has an
interest in the outcome of the project. This could include other project supervisors, customers, or anyone
who needs to know the status of the project. Microsoft Project lets you print the work schedule, task
assignments, milestone tasks accomplished, and many other types of information you enter into the
program. You can also print many types of reports that summarize other critical project data, like total costs
or overloaded work resources within a project file. These views and reports help you update the necessary
participants in the project with the information they require.

Now that you have a basic understanding of the purpose of project management and some of the
terms and concepts used, you should next examine the user interface within Microsoft Project. Before you
create a new project file, enter resources, and assign those resources to tasks within a project file, you
should first learn where the tools required to perform these tasks are located within the program’s
environment.

1.4- The Project Environment:

As with any program, you should begin learning Project by familiarizing yourself with its working
environment. If using Project 2013, you will see a “Welcome to Project” file appear the first time you open
Project. After reading and closing that file, the start-up screen appears. Project 2016 immediately opens to
the start-up screen. The start-up screen displays previously opened project files and templates you can use
to create a new project file. To create a new, blank project file, click the “Blank Project” template within the
start-up screen.

If this is your first time using Microsoft Project, note the default view of the new, blank project file.
This is named the “Gantt Chart” view of the project. This is only one of many possible project views
available in Microsoft Project. In the “Gantt Chart” view, project tasks appear at the left side of the window
within the “Entry” table view and the associated task durations appear in the bar chart to the right of the
tasks. A “Timeline” view of the project’s entire duration appears at the top of the view.

The project file appears inside of the outer application window. The project file window contains the
actual project data you are creating. You can open and close individual project file windows within a
Microsoft Project application window without closing the entire window.

Next, examine the names and locations of the tools needed to create your project files. The first tool
to learn about is the Ribbon shown at the top of the application window. The Ribbon contains the buttons
and commands you need to manage project files. This tool contains all of the command buttons available
within Microsoft Project. They are separated into button groups located on the tabs within the Ribbon. You
can click the buttons in the button groups on the tabs of the Ribbon to perform actions in Project.

One of the most important tabs in the Ribbon is the “File” tab, located in the upper-left corner of the
Ribbon. Clicking this tab lets you access the file-management commands, shown in the “backstage view” of
the project file. Commands for creating new project files, saving changes to project files, and printing project
files, are all found in the “backstage view” of the project file.

The Quick Access Toolbar is located above the Ribbon. You can add buttons to this toolbar for the
commands you use most frequently. Several important buttons already appear here: “Save,” “Undo,” and
“Redo.” You can easily add and remove buttons to and from this toolbar, which is discussed in a separate
lesson of this chapter. At the top of the window, the name of the currently opened project file appears to the
right of the Quick Access Toolbar in an area known as the Title Bar.
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Getting Acquainted with Project

1.4- The Project Environment- (cont'd.):

The currently opened project file appears below the Ribbon. This is where you enter and edit the
project data for the currently opened project file. When a project file is displayed using the “Gantt Chart”
view, a vertical scroll bar appears at the right side of the project file. A horizontal scroll bar also appears at
the bottom of the project file. You use the vertical scroll bar to scroll up and down through the content
shown in the view. You use the horizontal scroll bar to scroll laterally across the content shown in the
project file view.

You can easily zoom in to increase the project file’s magnification or zoom out to decrease its
magnification by using the “Zoom” slider in the lower right corner of the window. Commonly-used Project
View Buttons appears to the left of the “Zoom” slider. These buttons let you switch the view of your project
file, as needed.

Now you know the names of the major onscreen elements and where they are located by default.
Next, you will learn about these various onscreen elements within Project in more detail.

The Ribbon

Entry Bar

Timeline

Gantt Chart View
(shows tasks at left side and 
task durations at right side)

Status Bar

Scroll Bars

Quick Access Toolbar & Title Bar

1.5- The Title Bar:

The Title Bar is the thin bar that runs across the very top of the Microsoft Project application window.
The name of your currently opened project file appears in the center of this bar if your project file window is
maximized. At the right end of the Title Bar are three buttons in a button group: “Minimize,”
“Maximize/Restore Down,” and “Close,” respectively. These buttons change the display of the application
window.

Clicking the “Minimize” button sends the application window down to the Windows Taskbar. You can
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Getting Acquainted with Project

1.5- The Title Bar- (cont'd.):

view it later by clicking its entry within the Windows Taskbar.
Clicking the “Maximize” button enlarges your application window to full-screen size. It also toggles

the function of the same button to the “Restore Down” command. Clicking the “Restore Down” button
changes the size of the window to a smaller window, letting you size and position it onscreen by using your
mouse to click and drag within the Title Bar. After clicking the “Restore Down” button, it toggles back into
the “Maximize” button.

Clicking the “Close” button closes the entire application. If you have unsaved changes in the current
project file, you will be prompted to save those changes before the program closes. Also note that these
buttons, with the exception of the “Minimize” button, are duplicated in the “project window” inside the
application window. Here you use them to control the size of that window within the application window and
close the project file window without exiting Project entirely.

1.6- The Ribbon:

The Ribbon is the primary tool used in Microsoft Project. The Ribbon lets you perform all the
commands available. The Ribbon is divided into tabs. Within these tabs are different groups of commands.
The commands in each group are accessed by using the buttons, boxes, or menus shown within the group.

For advanced options or for users familiar with the older “dialog box” functionality, clicking the dialog
box launcher buttons shown in the lower right corner of some groups on the currently displayed, or “active,”
tab in the Ribbon opens a dialog box of options for that group. Also notice that you can double-click the
active tab of the Ribbon to both hide and show the contents of the Ribbon. This is a handy way to gain
additional workspace while working on your project.

You click the main tabs in the Ribbon to switch the groups shown. The default tabs in the Ribbon
are: “File,” “Task,” “Resource,” “Report,” “Project,” and “View.” You can also enable the “Developer” tab, if
using macros or code within a project file.

In addition to the primary tabs available in Project, special “contextual” tabs also appear within the
Ribbon. For example, the “Format” tab of the “Gantt Chart Tools” contextual tab appears in the Ribbon
when working in the Gantt Chart view of the project file. These contextual tabs will appear for each view in
your project. The commands and groups shown on the contextual tabs are directly related to the type of
project view or report object currently selected.

1.7- The “File” Tab and Backstage View:

You can click the “File” tab in the Ribbon to open a view of the file called the “backstage view.” In
this view, you can perform all your file management. This includes performing functions like saving a project
file, opening a project file, or creating a new project file. However, you no longer see the contents of the
project file.

The commands at the left side of the backstage view are the available file management commands.
After clicking a command at the far left side of the backstage view, additional options for the selected
command appear to the right in a new section. You can then make additional selections in the new section,
as needed. For example, to create a new project file, click the “New” command and then select the desired
project file template to use from the listing shown to the right in the backstage view.
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Getting Acquainted with Project

1.8- The Scroll Bars:

The scroll bars run both vertically and horizontally along the right and bottom sides of the panes that
are displayed within your project file view. They have little arrows at their ends that point in the direction
they scroll. You use the scroll bars to scroll through the content of your project file. You may click the arrows
to scroll through the file or click and drag the little box inside the scroll bars to a new location to scroll
through the content, as well.

1.9- The Quick Access Toolbar:

The Quick Access toolbar is located above the Ribbon, by default. However, if you want to place it
below the Ribbon, click the “Customize Quick Access Toolbar” button at the right end of the toolbar and
then select the “Show Below the Ribbon” command. You can reset it to its default location by clicking the
same “Customize Quick Access Toolbar” button and then choosing the “Show Above the Ribbon”
command.

This is the only toolbar available for use in Project. By default, you have buttons for quick access to
the following commands: “Save,” “Undo,” “Redo (Repeat).” However, you can easily add buttons to this
toolbar for the functions that you use most.

One way to add a button to the Quick Access toolbar is to right-click any command button or
function within the Ribbon which you want to add and then choose the “Add to Quick Access Toolbar”
command. The selected function will then be added to the Quick Access toolbar. To remove a button you
have added from the Quick Access toolbar, right-click the button to remove and then choose the “Remove
from Quick Access Toolbar” command.

To more thoroughly customize the Quick Access toolbar, click the “Customize Quick Access
Toolbar” button and then choose the “More Commands…” choice. This opens the “Project Options” window.
At the right side of the window are two sets of command button listings. The listing at the far right of the
window is the set of button commands currently shown in the Quick Access toolbar. The order in which the
commands appear, from top to bottom, is the order in which they appear from left to right in the Quick
Access toolbar.

The left listing shows the commands you can add to the Quick Access toolbar. To select which
functions appear in this list, select a command grouping to display from the “Choose commands from:”
drop-down above the list.

To add a command to the Quick Access toolbar from this list, click the command to add from the
choices shown in the left list. Then click the “Add>>” button between the lists to move the selected
command into the Quick Access toolbar list to the right.

To remove a command from the Quick Access toolbar list at the right, click it to select it, first. Then
click the “Remove” button between the lists to remove it from the list.

You can also change the order in which the buttons appear in the Quick Access toolbar by selecting
a command in the right list and then clicking either the “Up” or “Down” arrow buttons to the right of this list.
After customizing the content of the Quick Access Toolbar, click the “OK” button in the lower right corner of
the “Project Options” window to save and apply your changes.Sam
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Getting Acquainted with Project

1.10- The Entry Bar:

The Entry Bar is no longer displayed by default in Microsoft Project. Therefore, if you wish to use it,
you must enable its display. To do this, click the “File” tab in the Ribbon. Then click the “Options” command
at the left side of the backstage view to open the “Project Options” window. In the “Project Options” window,
click the “Display” category at left. To the right, check the “Entry bar” checkbox under the “Show these
elements” section. Then click the “OK” button at the bottom of the “Project Options” window.

When enabled, the Entry Bar appears as a large white bar where you can see, edit, and create
content within the currently selected cell in the project file. To edit or change content in selected cells, enter
the changes into the large white bar within the Entry Bar.

When you begin to type, a small checkmark button and a small “x” button appear to the left of the
entry. After entering or editing the content in the large white box, you can click the checkmark button that
appears to save the entry into the selected project cell. You can also click the small “x” button that appears
to cancel the entry.

1.11- The Status Bar:

At the bottom of the application window is the Status Bar. Within this bar you can see one of the
three modes for Microsoft Project at the left end: “Ready,” “Edit,” or “Enter.” If the word “Ready” appears,
Project is ready to do just about anything that you want. This is the mode that you want to see displayed in
the Status Bar before you begin a task.

The next mode you will often see displayed in the Status Bar is “Edit.” If you are in “Edit” mode, that
means that you have changed the content of a selected cell in your project file, but that you have not moved
from the cell to finish editing the contents. Many commands will be unavailable to you when you are in “Edit”
mode.

The last mode you will often see displayed in the Status Bar is “Enter.” This is much like the “Edit”
mode, but is shown when you are initially entering information into a blank cell within a project file. Just as
when using “Edit” mode, however, most commands will be unavailable to you until you finish data entry in
the currently selected cell, which then returns you to “Ready” mode.

Next to the cell mode indicator, you will see the task mode indicator. This determines how Project
schedules new tasks. It defaults to “New Tasks: Manually Scheduled,” but you can click it to change it to
“New Tasks: Auto Scheduled” if you desire. When you then create new tasks in your project, this setting
determines how the task dependencies will relate to each other when the tasks are linked within a project.
For most projects where you want to have the ability to change the duration of a predecessor task and then
have Project automatically reschedule the linked dependent tasks, you will want to create the tasks using
the “New Tasks: Auto Scheduled” task mode. We will discuss this feature in the chapter on tasks.
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Getting Acquainted with Project

1.11- The Status Bar- (cont'd.):

At the far right end of the Status Bar you can see the View Shortcuts and the Zoom slider. You can
click the View Shortcuts buttons to quickly switch between the most commonly used views of your project
file.

You can use the Zoom Slider to change the magnification level of the view of your project file. This
does not modify the file in any way, but rather changes your perception of how close or far away the
contents appear onscreen. You can click and drag the slider left towards the minus symbol to decrease the
magnification level. You can also click and drag the slider to the right, or towards the plus sign, to increase
the magnification level. For many views, such as the default Gantt Chart View, note that this changes the
timescale aspects shown in the view, but does not change the magnification of the task list shown in the
view. It does magnify all aspects of graph views when used.

1.12- Touch Mode:

Project 2013 and later uses “Touch Mode” for easier access to the buttons and other commands
within the Ribbon and Quick Access toolbar. When you enter touch mode, the Ribbon and Quick Access
toolbar are enlarged. Extra space is added around the buttons and commands contained within them to
help you easily access the buttons on a touch-based tablet.

To enable touch mode, click the small drop-down arrow at the right end of the Quick Access toolbar
to display a listing of the most commonly used commands. Then click or tap the “Touch/Mouse Mode”
command in the drop-down menu to add that button to the Quick Access toolbar.

To then enable or disable touch mode, click or tap the “Touch/Mouse Mode” button in the Quick
Access toolbar. From the drop-down menu that then appears, select the mode you prefer to use: “Mouse” or
“Touch.” When “Touch” mode is enabled, the buttons within the Ribbon and Quick Access toolbar appear
larger with more space surrounding them onscreen. You can select the “Mouse” choice to toggle touch
mode off, restoring the default size of the onscreen buttons.
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ACTIONS-
Getting Acquainted with Project

THE TITLE BAR:

1. To minimize the application to the Windows taskbar, click the “Minimize” button in the Title Bar.
2. To view it again after minimizing it, click its entry in the Windows Taskbar.
3. To maximize the amount of display space available, click the “Maximize” button.
4. To use a smaller window that you can move onscreen with your mouse by clicking and dragging

in the Title Bar, click the “Restore Down” button, which replaces the “Maximize” button when the
window is already maximized.

5. After clicking the “Restore Down” button, it toggles back into the “Maximize” button.
6. To close the application window, click the “Close” button.
7. If you have unsaved changes in any open project file, you will be prompted to save those changes

before the application closes.
8. These buttons, with the exception of the “Minimize” button, are duplicated in the project window inside

the application window where you use them to control the size of the project file window within the
application window and close the project file window without exiting Project entirely.

THE RIBBON:

1. To switch the commands shown in the Ribbon, click the tabs.
2. Commands in a tab are accessed using the buttons, boxes, or menus shown within the button groups.
3. To access dialog boxes for some button groups in a tab, click the dialog box launcher button in the

lower right corner of some groups on the currently displayed, or “active,” tab in the Ribbon.
4. To both hide and show the contents of the Ribbon, double-click the active tab of the Ribbon.
5. The default tabs in the Ribbon are: “File,” “Task,” “Resource,” “Report,” “Project,” and “View.”
6. You can also enable the “Developer” tab, if using macros or code within a project file.
7. In addition to the primary tabs available in Project, special “contextual” tabs also appear within the

Ribbon. For example, contextual tabs will appear for each view in your project.
8. The commands and groups shown on the contextual tabs are directly related to the type of project view

or report object currently selected.

STARTING PROJECT:

1. To start Microsoft Project if you have a desktop icon, double-click the Microsoft Project desktop
icon.

2. Alternatively, click the entry for “Microsoft Office Project” within the Windows Start Menu or Start
Screen.

THE “FILE” TAB AND BACKSTAGE VIEW:

1. To see the “backstage view” of a project file, click the “File” tab in the Ribbon.
2. The commands shown at the left side of the view are the available file management commands.
3. When you click a command at the far left side of the backstage view, additional options for the selected

command appear to the right in a new section.
4. Make additional selections in the new section, as needed.
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ACTIONS-
Getting Acquainted with Project

THE SCROLL BARS:

1. To scroll through the project file, click the arrows at the ends of the scroll bars.
2. Alternatively, click and drag the little box inside of the scroll bars to a new location to scroll.

THE QUICK ACCESS TOOLBAR:

1. To place the Quick Access toolbar below the Ribbon, click the “Customize Quick Access Toolbar”
button at the right end of the toolbar and then select the “Show Below the Ribbon” command.

2. To reset its default position, click the same “Customize Quick Access Toolbar” button and then
choose the “Show Above the Ribbon” command.

3. To add a button to the Quick Access toolbar, right-click the command button or function within the
Ribbon to add and then choose the “Add to Quick Access Toolbar” command.

4. To remove a button you have added from the Quick Access toolbar, right-click the button to
remove and then choose the “Remove from Quick Access Toolbar” command.

5. To more thoroughly customize the Quick Access toolbar, click the “Customize Quick Access
Toolbar” button and then choose “More Commands…” from the drop-down menu to open the “Project
Options” window.

6. At the right side of the panel are two sets of command button listings.
7. The listing at the far right of the panel is the set of button commands that are currently shown in the

Quick Access toolbar. The order in which the commands appear, from top to bottom, is the order in
which they appear from left to right in the Quick Access toolbar.

8. The left listing shows the commands you can add to the Quick Access toolbar.
9. To select which functions appear in this list, select a command grouping to display from the “Choose

commands from:” drop-down above the list.
10. To add a command to the Quick Access toolbar from this list, click the command to add from the

choices shown in the left list.
11. Then click the “Add>>” button between the lists to move the selected command into the Quick Access

toolbar list to the right.
12. To remove a command from the Quick Access toolbar list at the right, click it to select it, first.
13. Then click the “Remove” button between the lists to remove it from the list.
14. To change the order in which the buttons appear in the Quick Access toolbar, select a command

in the right list and then click either the “Up” or “Down” arrow buttons to the right of this list.
15. To save and apply your changes after customizing the content of the Quick Access Toolbar, click

the “OK” button in the lower right corner of the “Project Options” window.

THE ENTRY BAR:

1. To show the entry bar if it is not displayed, click the “File” tab in the Ribbon.
2. Then click the “Options” command at the left side of the view to open the “Project Options” window.
3. In the “Project Options” window, click the “Display” category at left side of the window.
4. To the right, check the “Entry bar” checkbox under the “Show these elements” section.
5. Then click the “OK” button at the bottom of the “Project Options” window.
6. To use the entry bar to edit or change content of selected cells, enter the changes into the large

white bar within the Entry Bar.
(cont’d.)
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ACTIONS-
Getting Acquainted with Project

THE ENTRY BAR (CONT’D.):

7. When you begin to type, a small checkmark button and a small “x” button appear to the left of the entry.
8. To save the entry into the selected cell after entering or editing content within the large white

box, click the checkmark button that appears.
9. To cancel the entry, instead, click the small “x” button that appears.

THE STATUS BAR:

1. To view Microsoft Project’s current cell entry mode, look in the Status Bar at the bottom of the
application window.

2. If the word “Ready” appears, Project is ready to begin a task.
3. If “Edit” or “Enter” appears, finish data entry in the currently selected cell and exit the cell to return to

“Ready” mode.
4. To view the current task mode, look at the task mode indicator in the Status Bar.
5. It defaults to “New Tasks: Manually Scheduled,” but you can click it to change it to “New Tasks: Auto

Scheduled.”
6. To quickly switch between the most commonly used views of your project file, click the View

Shortcuts buttons in the Status Bar.
7. To change the magnification level of your project file’s view, use the Zoom Slider in the Status Bar.
8. To decrease the magnification level, click and drag the slider left towards the minus symbol.
9. To increase the magnification level, click and drag the slider to the right, or towards the plus sign,.
10. For many views, like the default Gantt Chart View, note that this changes the timescale aspects in the

view, but does not change the magnification of the task list shown in the view. It does magnify all
aspects of graph views when used.

TOUCH MODE:

1. To enable touch mode, click the small drop-down arrow at the right end of the Quick Access toolbar to
display a listing of the most commonly used commands.

2. Then click or tap the “Touch/Mouse Mode” command in the drop-down menu to add that button to the
Quick Access toolbar.

3. To enable or disable touch mode, click or tap the “Touch/Mouse Mode” button in the Quick Access
toolbar.

4. From the drop-down menu that then appears, select the mode you prefer to use: “Mouse” or “Touch.”
5. When “Touch” mode is enabled, the buttons within the Ribbon and Quick Access toolbar will appear

larger and with more space surrounding them onscreen.
6. You can select the “Mouse” choice to toggle touch mode off, restoring the default size of the buttons

onscreen.Sam
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EXERCISES-
Getting Acquainted with Project

Purpose:

1. To be able to find the basic tools in the Microsoft Project application environment.

Exercises:

1. Open Microsoft Project.
2. Click the “Blank Project” button within the startup screen to create a new, blank project file.
3. Locate the Ribbon within the application interface.
4. Locate the Status Bar within the application interface.
5. Click the “Resource” tab in the Ribbon to see the buttons that are available.
6. Click the “Task” tab in the Ribbon to see the button groups available.
7. Exit the Microsoft Project application by clicking the “x” button in the upper right corner of the application

window.
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